# Table of Contents

1. **Introduction** ................................................................................................................. 1  
   1.1 **What is Reliance Web Client** ..................................................................................... 2  
   1.2 **Starting the Web client** .............................................................................................. 3  
      1.2.1 **Starting as a Java applet** ................................................................................... 4  
      1.2.2 **Starting as an application via Java Web Start** .................................................... 5  
      1.2.3 **Starting as a common application** ........................................................................ 5  
      1.2.4 **Entering access code** .......................................................................................... 6  
      1.2.5 **Adjusting project resolution** ............................................................................. 6  

2. **Web Client description** .................................................................................................. 8  
   2.1 **Web Client user interface** .......................................................................................... 9  
      2.1.1 **Main window** .................................................................................................... 10  
      2.1.2 **Title bar** ........................................................................................................... 11  
      2.1.3 **Main menu** ...................................................................................................... 12  
      2.1.4 **Toolbar** ........................................................................................................... 15  
      2.1.5 **Visualization windows** ..................................................................................... 15  
      2.1.6 **Bottom alarms/events panel** ............................................................................. 16  

2.2 **User logon/logoff** ........................................................................................................ 17  
2.3 **Editing tag values** ....................................................................................................... 18  
   2.3.1 **Editing tag value** .................................................................................................. 18  
   2.3.2 **Editing tag limits** ................................................................................................. 18  

2.4 **Alarm/Event viewers** .................................................................................................. 20  
   2.4.1 **Current Alarm/Event viewer** ................................................................................. 20  
   2.4.2 **Historical Alarm/Event viewer** ........................................................................... 23  

2.5 **Trend viewers** ............................................................................................................. 25  
   2.5.1 **Toolbar commands** ............................................................................................... 25  
   2.5.2 **Defined Trend viewer** .......................................................................................... 27  
   2.5.3 **Tag Trend viewer** ................................................................................................ 28  

2.6 **System Information** .................................................................................................... 29  
2.7 **Information dialogs** .................................................................................................... 31  
   2.7.1 **Tag Information dialog** ........................................................................................ 31  
   2.7.2 **Alarm/Event Information dialog** .......................................................................... 32  
   2.7.3 **User Information dialog** ...................................................................................... 33  

2.8 **Virtual keyboard** .......................................................................................................... 35
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.9</td>
<td>Text Data Viewer</td>
<td>36</td>
</tr>
<tr>
<td>2.10</td>
<td>Common GUI elements</td>
<td>39</td>
</tr>
<tr>
<td>2.10.1</td>
<td>Window menu</td>
<td>39</td>
</tr>
<tr>
<td>2.10.2</td>
<td>Virtual keyboard button</td>
<td>39</td>
</tr>
<tr>
<td>2.11</td>
<td>Options</td>
<td>40</td>
</tr>
<tr>
<td>3</td>
<td>Appendix</td>
<td>43</td>
</tr>
<tr>
<td>3.1</td>
<td>Glossary</td>
<td>43</td>
</tr>
</tbody>
</table>
1 Introduction

The **Web client** (*Reliance Web Client*) and the client designed for use with smartphones and tablets (*Reliance Smart Client*) are commonly referred to as **thin clients**. The thin clients are designed for comfortable access to a visualization application from remote locations. The thin clients connect to *data servers* and provide similar visualization features as the *runtime software*. This document describes the *Web client*.

What is Reliance Web Client?

Web Client Start
1.1 What is Reliance Web Client

Reliance Web Client is software designed for running a visualization application on a remote computer connected to the network (the Internet). It enables remote users to view real-time data, control the visualized process, view and acknowledge alarms/events and view trends and reports. Reliance Web Client uses one of the Reliance data servers (Reliance Server or Reliance Control Server) as a data source. Communication between the Web client and the data server is based on Web services and the SOAP protocol. The communication messages of the SOAP protocol are encrypted and compressed.

The Web client is based on the Java platform from Sun Microsystems. The GUI is based on the JFC/SWING library from the same company. Java is available for many different operating systems such as MS Windows, Linux, Unix, Mac OS X, etc. The Web client doesn't depend on the installed Web browser and it can be started from MS Internet Explorer, Mozilla Firefox, Konqueror, Safari, Google Chrome, etc.
1.2 Starting the Web client

The most common way to start the Web client is via a link located on the data server's Web page. Reliance data servers (Reliance Server and Reliance Control Server) contain a built-in Web server to provide Web pages. For more information about data servers refer to a specialized document named Data Servers.

Welcome!
Welcome to Reliance 4 Control Server Web page.

Project
Choose the project part you want to display.

Devices and Tapes
Current Alarm/Events
Reports
Custom Reports

Status
Name | Value
--- | ---
Version | 5.0.3.28.13
Serial Number | 4115676
Data Points | 90000
Thin clients | 4/154
Project | AirCondition
Computer | pc1

Thin Clients
Choose what kind of thin client you want to start.

Reliance Web Client
To start the Web client (Reliance Web Client) use this page.

Reliance Mobile Client
To download the mobile client (Reliance Mobile Client) use this page.

Server
Administration

Data server – Main page
**Note:** The Web page required to start the Web client is available only after a visualization project has been exported for remote users. The export for remote users can be done from the Reliance Design development environment (Enterprise edition) via the > Project > Export for Remote Users command. For more information on Export for Remote Users Wizard see the Development Environment help.

To display the list of configurations available for the Web client, select the Reliance Web Client link in the Thin Clients section of the data server's main page.

### Configurations

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Run</th>
<th>Run (direct links)</th>
</tr>
</thead>
<tbody>
<tr>
<td>pc1</td>
<td>Applet Java Web Start</td>
<td>Applet Java Web Start</td>
</tr>
<tr>
<td>pc2</td>
<td>Applet Java Web Start</td>
<td>Applet Java Web Start</td>
</tr>
</tbody>
</table>

- **Show direct links (no Java Plugin detection)**

**Notes**

Reliance 4 Web Client requires Java Plugin 6.0.

It is recommended that you start Reliance 4 Web Client via Java Web Start.

### Configurations

Each configuration corresponds to a computer defined in the visualization project. The Web client can be started as a Java Applet, as a Java Web Start application (recommended) or as a common Java application.

- **Java Applet**
- **Java Web Start**
- **Java Application**

In some cases dialog box asking the user to enter Access code or query about a project resolution adjustment can appear.

- **Entering Access Code**
- **Adjusting Project Resolution**

### 1.2.1 Starting as a Java applet

A Java applet is a software element (program) running in the context of a Web browser – it is part of a Web page and starts when the page is loaded. The functionality of Java applets in
Web browsers is provided by Java Plugin which is part of JRE (Java Runtime Environment) – the runtime environment developed by Sun Microsystems for Java-based programs.

To start an applet, click the 'Applet' link on the list of configurations page. You are redirected to the page with a simple applet which is designed to detect if JRE 6.0 is installed on your system. If JRE 6.0 is not installed, it can be installed automatically (if an automatic installation is not possible, the user is provided with the information on how to install JRE 6.0 manually).

If JRE 6.0 is detected, the user is redirected to the page with the Web client applet. The Web client is downloaded and started after the user acknowledges a security certificate. After the Web client applet starts, the visualization project is automatically downloaded and started. Both the Web client applet and the visualization project are downloaded only once and stored on the local computer to speed up next start (the program and project files are downloaded again only if a new version is available). The main disadvantage of running the Web client as an applet is that it requires a Web browser to also be running.

### 1.2.2 Starting as an application via Java Web Start

Java Web Start (JWS) is part of JRE and it is a system designed to start Java applications directly from the Internet without starting the Web browser. A Java application can be started via JWS for example by clicking on a file (link) with a .jnlp extension (Java Network Launching Protocol). A JNLP file contains basic information about the program – program name, version, program files location and other information and rules.

After clicking the "Java Web Start" link in the list of configurations, the .jnlp file is downloaded and processed by the Java Web Start system. If the up-to-date version of the Web Client is already stored (cached) on the computer, it is started (if a later version of the Web Client is available on the server it is first downloaded and then started). Next steps of the starting procedure are similar to the applet. The Web Client started via Java Web Start is installed in a similar way as common applications (e.g. on Windows, you can find it in the Start menu) – this feature can be disabled when a project is exported for remote users.

### 1.2.3 Starting as a common application

If for any reason, it is not possible to start Web Client via any of above discussed methods (Java applet or Java Web Start), it can be started as a common Java application. Typically starting Web Client as a common application is required if it is not possible to install JRE 6.0 on the local computer, because it would conflict with already installed JRE (which is required by another application). In this case, it is possible just to copy JRE files to the computer (do not install it) and to start Web Client using one of the following files:
config_0.bat (OS Windows batch file)
R_WebClientLauncher_config_0.exe (starts config_0.bat)
config_0_linux.sh (OS Linux script)
config_0_masoc.sh (Mac OS script)

**Note:** Paths used in the batch files must be edited (adjusted) to reflect the location where JRE have been copied.

If Web Client is started as a common Java application it is required to manually copy program files onto the local computer and to keep this files up-to-date if visualization project on the data server is changed (this is not required with Java Applet or Java Web Start where it is done automatically). If project file version on the server and on the local computer differs, Web Client may not work properly (if version differs, warning is shown). For this reason starting Web Client as a common application is not recommended.

### 1.2.4 Entering access code

Access to Web Client can be protected with an access code. If this is the case, the *Enter Access Code* dialog is displayed on application start. Loading of the application won't continue until correct password is entered.

![Enter Access Code](image)

**Enter Access Code**

### 1.2.5 Adjusting project resolution

Confirmation dialog is shown if current display resolution doesn't correspond to the project
resolution (if project was designed for different resolution). To keep the original main window size (resolution) select **Yes**, to resize visualization (main window and components) to fit current display resolution select **No** button.

**Adjusting Project Resolution**

To remember the answer check *Don’t show this message again*. If you want to show the confirmation dialog again, you can change the behaviour via **Options**.
2 Web Client description

Web client user interface
User logon/logoff
Editing tag values
Alarm/Event viewers
Trend Viewer
System Information
Information Dialogs
Virtual Keyboard
Text Data Viewer
Common GUI elements
Options
2.1 Web Client user interface

The splash screen contains progress bar which shows the status while a visualization project is downloading from a data server and/or loading into memory.

Main Web Client window is displayed after the download is finished.

Main window
Title bar
Main menu
Tool bar
Visualization windows
Bottom Alarms/Events panel
2.1.1 Main window

Main window is divided into following parts (top – down)
- title bar (1)
- main menu (2)
- toolbar (3)
- area for visualization windows (4)
- bottom alarms/events panel (5)
All main window parts (except visualization windows) can be hidden by a developer (system integrator). Size (resolution) of the visualization window is defined when project is exported and can't be manually changed from the Web Client.

### 2.1.2 Title bar

Title bar shows a standard window title in the following format:

```
Reliance 4 Web Client (<type>) - [<project_name>] - <status>
```

where:

- `<type>` indicates whether Web Client was started as an applet, common application or via Java Web Start
- `<project_name>` contains a name of loaded project
- `<status>` indicates the state of connection between a client and a server; state can be: "Disconnected", "Connecting", "Connected", "Disconnecting".
2.1.3 Main menu

Main menu contains the following items: **File**, **View**, **Tools**, **Window** and **Help**.

- **File Menu**
  - **Logon User** (Ctrl+L)
    - Shows the dialog window for the user logon.
  - **Logoff User**
    - Logs off the user from the data server.
**Logged-On User Information**

Displays dialog window with the information about the current user.

**Project Language**

Shows the list of defined project languages. You can switch the language of project defined objects (labels, alarms/events texts, etc.)

**Program Language**

Shows the list of program languages (Czech, English, Polish, Russian, German, Lithuanian, Hungarian). You can switch the program language (GUI language – main menu, alarm/event viewer, etc.).

**Print Main Window**

Brings up the standard OS print dialog which allows you to select a printer and configure print settings in order to print the image of the program’s main window.

**Connect**

Connects to the data server.

**Disconnect**

Disconnects from the data server.

**Exit**

Closes the Web Client.

**View Menu**

**Current Alarms/Events (Alt+A)**

Activates Current Alarms/Events viewer.

**Historical Alarms/Events**

Activates Historical Alarms/Events viewer.
**Web Client user interface**

*Trend (Ctrl+T)*

Shows the list of defined trends; selected trend can be displayed in the Defined Trends viewer.

*Tag Trend*

Shows the list of defined tags; a trend of selected tag can be displayed in the Tag Trend viewer.

*Report (Ctrl+R)*

Shows the list of defined reports; selected report can be displayed in the default web browser.

*Custom Report (Alt+R)*

Shows the list of defined custom reports; selected custom report can be displayed in the default web browser.

**Tools Menu**

*Virtual Keyboard*

Activates Virtual Keyboard.

*Server Web Page*

Opens data server’s web page in the default web browser. For detailed data server description refer to specialized document.

*System Information*

Displays a dialog window containing System information.

*Options*

Enables the user to change various Web Client options.

**Window Menu**

*Previous Window (Ctrl+Shift+Left)*

Activates previous visualization window in the history of activated windows.
**New Window** (Ctrl+Shift+Right)

Activates next visualization window in the history of activated windows.

**Help Menu**

*Index and Content* (F1)

Displays this document.

*Reliance on Internet*

Opens the **Reliance** web page in the default web browser ([www.reliance.cz](http://www.reliance.cz)).

*About Reliance Web Client*

Shows a window with the **Web Client** basic information (version, system information etc.)

**Note:** Some commands from the *Main menu* can be accessed directly from visualization windows.

### 2.1.4 Toolbar

Most commonly used commands are also accessible in the toolbar. The right part of the toolbar contains system time and a window menu (a combo box with *Minimize* and *Close* commands). If any user is logged on, it is indicated with an icon (click the icon to display *Active User Information*).

### 2.1.5 Visualization windows

The contents of visualization windows is specific for every visualization project. The help document for visualization windows (screens) is usually provided by a system integrator (visualization developer). Common parts of the user interface are:

- the dialog window *Enter Tab Value*
- the dialog window *Enter Tag Limits*
- standard component's *Local menu*
Some components (visual objects located inside a visualization window) have *Local menu*, which can be activated by the right mouse button. Usually only components designed to display the tag values have the *Local menu* (e.g. Display).

![Local Menu](image)

### Local Menu

Standard component's local menu contains the following commands:

*Tag Trend*

Displays *Tag Trend* in a trend viewer.

*Tag Information*

Shows the dialog window with *Tag Information*.

*Update Tag Value*

Sends tag value update request to the *data server*. It is used for manual update of a tag value stored in the PLC, telemetric device etc.

*Enter Tag Value*

Shows the dialog window *Enter Tag Value*.

*Enter Tag Limits*

Shows the dialog window *Enter Tag Limits*.

### 2.1.6 Bottom alarms/events panel

*Bottom alarms/events panel* is a control designed to provide an easy access to *Current alarms/events*. Only one *alarm/event* is displayed at a time. It is easy to switch between current alarms/events with the *Previous* and *Next* buttons. Other control buttons are similar to those used in the *Current Alarms/Events viewer*. Depending on the project options, panel can be permanently shown, permanently hidden or automatically shown when a new alarm/event is started (generated).
2.2 User logon/logoff

Access to the parts of a visualization project and/or to selected operations can be protected with access rights. Only if you are logged on and if you have the sufficient set of access rights you can access specific parts of the project. You can log onto the system via the > File > Logon User command (or via toolbar).

Enter the user name and password to log onto to the system. Web Client have to be connected to the Data server to perform this operation.

To display Logged User Information use the > File > Logged On User Information command (shows Id, Name and Alias).

Active user can be logged off via the > File > Logoff command.
2.3 Editing tag values

Editing Tag Value

2.3.1 Editing tag value

The *Enter Tag Value* dialog is designed to preview, change or edit value of a tag. Type of the controls used to enter/preview a tag value corresponds to the type of a tag according to the following list:

<table>
<thead>
<tr>
<th>tag type</th>
<th>control type</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean (binary value)</td>
<td>radio button</td>
</tr>
<tr>
<td>number (integer, float)</td>
<td>edit box with arrows (spinner)</td>
</tr>
<tr>
<td>string</td>
<td>edit box (multiple lines)</td>
</tr>
</tbody>
</table>

To show the dialog window *Tag Information* click the "i" button.

2.3.2 Editing tag limits

So called *limits* can be defined for the numerical type tags. The limits are used to evaluate alarms/events, etc. For each tag four limits can be defined:
High Critical

High Warning

Low Warning

Low Critical

Limit can be defined as static (it's value is set when a project is designed) or dynamic (limit can be changed during a runtime).
2.4 Alarm/Event viewers

**Alarm/Event** is started (triggered, generated) when defined condition is met (e.g. tag value changes or it is out of range). It usually indicates some error state (in which case it is called an *alarm*) or it can indicate common state or information, e.g. when tag value is changed by the user (in which case it is called an event). User with sufficient access rights is permitted to **acknowledge** the alarm/event with the acknowledge command, to inform the system (and other users) that he/she is aware of the problem.

Each *alarm/event* is displayed in the *Current/Historical alarms/events list* according to the following rules:

<table>
<thead>
<tr>
<th>state</th>
<th>current</th>
<th>historical</th>
<th>background color</th>
</tr>
</thead>
<tbody>
<tr>
<td>not active, not acknowledged</td>
<td>yes</td>
<td>yes</td>
<td>white</td>
</tr>
<tr>
<td>not active, acknowledged</td>
<td>no</td>
<td>yes</td>
<td>white</td>
</tr>
<tr>
<td>active, not acknowledged</td>
<td>yes</td>
<td>yes</td>
<td>red</td>
</tr>
<tr>
<td>active, acknowledged</td>
<td>yes</td>
<td>yes</td>
<td>yellow</td>
</tr>
</tbody>
</table>

**Note:** *Alarm/Event* is active, if condition that generated it is still met.

Current Alarms Events

Historical Alarms/Events

2.4.1 Current Alarm/Event viewer

**Current Alarm/Event viewer** is a window containing the list of all *alarms/events* that are active or not yet acknowledged.
Current Alarm/Event viewer

The toolbar and the local menu contains following commands:

**Acknowledge**
 Acknowledges selected alarms/events.

**Acknowledge All**
 Acknowledges all alarms/events in the list.

**Activate Related Window**
 Activates the window that contains visualization related to the selected alarm/event.

**Alarm/Event Information**
 Displays a dialog with an Information about the selected alarm/event (information dialog can be displayed with a double click on the alarm/event too).

**Alarm/Event Note**
 Displays a dialog with an note of the selected alarm/event. For example, the note may describe the measures taken to solve the problem. Before acknowledging some of alarms/events you must write a note. User is invited to enter a note before acknowledging that alarms/events.
Show Data As Text

Shows the list of alarms/events as a text in the Text Data Viewer.

Options

Shows the Web Client Options dialog window– it enables you to configure the list of displayed columns.

Filter

Activates/deactivates a filtering of alarms/events in the list.

To choose a parameter by which the list will be sorted click on the column header. The Filter feature can be used to narrow down the number of displayed alarms/events in the list. First three control elements from the right side of the toolbar are used to define a filter. Alarms/events can be filtered by a device (show only alarms/events contained in a selected device) or/and by a part of the text (alarm/event text contains entered string).
The Alarms/Events list is automatically updated – this means that every time an alarm/event is generated, acknowledged or expires (condition which generated alarm no longer exists), the list is updated to contain current information (in contrast to the Historical alarms/events viewer). After reconnecting to a data server, the whole list is updated.

Bottom panel contains the number of alarms/events, value of this number is not effected by an applied filter. Alarms/Events viewer is not modal, which means that the user can work with the Web Client even if the list is opened.

**Note:** Depending on the visualization project, the Alarm/Event list can be inserted into a visualization window.

### 2.4.2 Historical Alarm/Event viewer

**Historical Alarm/Event viewer** is a tool designed to browse alarms/events stored in the database. The list contains all alarms/events – even inactive and acknowledged ones (in contrast to Current Alarms/Events viewer). Commands and filtering options accessible via toolbar are similar to those in the Current Alarm/Event viewer.

![Historical Alarm/Event viewer](image)

After the viewer is opened, limited number of last (depending on column used for sorting) alarms/events is downloaded from the data server. To download older or newer records, use Download Previous Historical Alarms/Events or Download Next Historical Alarms/Events commands (downloaded records depend on column selected for sorting).

To download all alarms/events that were started in a defined interval, use the Download Historical Alarms/Events command.
Downloading Alarm/Event in a defined interval

The list of Historical Alarms/Events is not updated automatically. To update the list, use the Refresh Historical Alarms/Events command.
2.5 Trend viewers

**Trend viewer** is a tool designed to show historical data in the form of a trend (a chart where X axis is always time). *Web Client's* trend viewer is designed to show two different types of trends: **defined trend** – trend predefined in *Trend Manager* (see *Runtime software* help) and **tag trend** – trend showing values of selected tag (contains one series).

Data viewed in the *Trend viewer* is downloaded from the data server when they are needed and cached by the viewer to speed up browsing. After the viewer is closed, cache is deleted. Any part of the trend can be magnified with the **zoom** function – to define the area that should be magnified, drag the mouse from top left to bottom right. To display the trend in original size (cancel zoom), drag the mouse from bottom right to top left.

Right side of the *Trend Viewer* contains a **Quick Setup Panel**. It is designed to make quick changes in the basic trend settings (3D view, title and legend visibility, axis ranges). To show hidden **Quick Setup Panel**, select an appropriate command from the toolbar.

Trend settings are automatically stored on the local computer in the user’s profile (profile in the OS) and is separate for every project.

Bottom panel contains the information about a number of downloaded/displayed samples (sum of samples contained in all series). Trend viewer is not modal, which means that the user can work with the *Web Client* even if the list is opened.

**Toolbar commands**

- Defined trend
- Tag trend

### 2.5.1 Toolbar commands

Toolbar and trend viewer local menu contains following commands:

- **Full Backward**
  - Scrolls the trend view backward by full time range (page).

- **Half Backward**
  - Scrolls the trend view backward by half a time range (page).
**Half Forward**
Scrolls the trend view forward by full time range (page).

**Full Forward**
Scrolls the trend view forward by half a time range (page).

**Forward to Latest**
Scrolls the trend view forward to the latest data.

**Custom Time Axis Range**
Brings up the dialog that enables you to manually specify the time range. If the time range is specified as a number of samples, the time is defined with a time stamp, direction and sample count. If the time range is specified as a time, it is defined with a beginning and ending time stamp.

**Note:** If a Tag trend is used, the range is defined with a time stamp, direction and sample count.

![Custom Time Axis Range](image)

**Show Tag Information**
Shows the Tag Information dialog window; command is present only for tag trends (if trend viewer is opened via File > Tag Trend).
Copy To Clipboard

Inserts the picture of a currently displayed trend to the system clipboard, so the picture can be pasted to a third party application.

Print

Opens a dialog window to configure and print displayed trend.

Save To File

Exports trend to a selected image file. File format is defined by a file extension (PNG, JPG, GIF, BMP).

Show Data As Text

Displays trend data in Text Data viewer.

Show Quick Setup Panel

Shows hidden Quick Setup Panel containing basic trend settings (3D view, title and legend visibility, axis ranges). Quick Setup Panel also allows to show the Ruler to get values of series in selected date/time. If the Auto-scroll parametr is active then the trend view is periodically (10s) scrolled forward to the latest data. In case of Tag Trend viewer it is also possible to set visibility of tag limits.

Chart Settings

Displays a dialog window with detailed trend settings.

Default Chart Settings

Resets trend settings to default.

2.5.2 Defined Trend viewer

The viewer is designed to show historical data of the tags defined in the project. Displayed time range of the trend is predefined in a trend definition, but it can be manually adjusted changing by Custom Range in Quick Setup Panel. Time range is defined by a number of samples. Settings is saved for each defined trend.
28 Trend viewers

[Image of Trend Viewer interface]

**Defined Trend Viewer**

### 2.5.3 Tag Trend viewer

*Tag Trend viewer* is designed to show historical data of a **single tag**. If tag limits are defined they are shown as horizontal lines in the trend. Yellow lines mark warning limits, red lines mark critical limits. Settings made to trend viewer are stored globally (tag trend settings are not tag specific).
2.6 System Information

System Information provides information and diagnostics about running Web Client and visualization project.

System Information – Communication

Dialog window contains the following tabs:

Project

Provides information about current project (name, computer name, export time and date, up time). List located at the bottom part of the Project tab contains an overview of objects defined in a project. Objects are listed by the categories (tags, devices, trends, windows etc.).
Communications

The first line contains text information about the state of the communication (possible states are listed in the topic **Title bar**). If connection to a data server can't be established, information about cause of the problem is displayed at the bottom of the Communications panel (e.g. Can't connect (connection refused)).

**Host**

Data server address.

**Port**

Data server TCP port.

**Session Count**

Indicates the number of thin clients connected to the data server (currently connected / maximum available licenses).

**Logged-On User**

Name of the currently logged-on user.

**Requests**

Number of packets (communication messages) send to the data server; number in parenthesis indicates a number of packets to be send.

**Responses**

Number of packets (communication messages) received from the data server; number in the parenthesis indicates a number of packets waiting in the queue.

**System**

Contains a basic information about Web Client program (Java active thread count, memory usage and Java properties etc.).

**Timers and Threads**

Informs about the activity of timers and threads. Gray lamp (not blinking) signalizes that corresponding thread is not running due to an error.

*System Information* window is not modal, which means that the user can work with the Web Client even if it is opened.
2.7 Information dialogs

Tag Information
Alarm/Event Information
User Information

2.7.1 Tag Information dialog

The Tag Information dialog contains information on tag's definition (Id, Name, Data Type etc.) and information on current tag's state (Value, Time Stamp, Quality etc.). The dialog window can be accessed e.g. from the Enter Tag Value dialog. Information on tag state is periodically updated.
2.7.2 Alarm/Event Information dialog

The **Alarm/Event Information** dialog contains information on defined alarm/event (Id, Name, Text etc.) and information on alarm/event current state (Data and Time of alarm/event's Start, End or Acknowledgement). The dialog window can be accessed for example via command in the **Current Alarm/Event viewer**. Information on an alarm/event current state is automatically updated. The **Tag Information** dialog and the **User Information** dialog can be accessed from this window.
2.7.3 User Information dialog

The **User Information** dialog window contains basic information on a user (Id, Name and Alias). Information about currently logged user can be accessed via the > File > Logged-On
User Information command or via the icon on the right side of the main toolbar.
2.8 Virtual keyboard

If it is required, values can be entered by Virtual keyboard. This is very useful especially if Reliance Web Client is operated on a computer without a keyboard (e.g. a touch panel).

Virtual Keyboard

Numerical keypad can be easily hidden with the Num. Pad key. The size and the layout of the virtual keyboard can be adjusted via combo boxes located at the top left part of the window.

Note: Changing layout of the virtual keyboard to required language settings changes only key labels. Real meaning of the keys depends on the layout selected in operation system (usually with ALT + SHIFT).
2.9 Text Data Viewer

*Text Data Viewer* is a dialog window designed to view (usually historical) data as a text. The viewer can be used to display *Alarm/Event list* or *Trend data* in a simple text form. Data values are separated by the semicolon by default, but the *separator* can be changed. The list can optionally contain *Title, Header and Footer*. Data in the text form can be easily copied to the clipboard and used by another application (e.g. MS Excel). Data can also be saved to a file in the CSV format.
# Text Data Viewer

The Text Data Viewer is a tool for viewing and manipulating text data. It features a list of data entries, each with a date and time stamp, followed by one or more numerical values.

### Toolbar Commands:

- **Select All**
  
  Selects all rows of the list.

- **Copy To Clipboard**
  
  Copies selected text to the clipboard.

---

### Example Data:

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Value 1</th>
<th>Value 2</th>
<th>Value 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>29.10.2008</td>
<td>22:35:50</td>
<td>0.0:0.0:10.0:100.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:35:52</td>
<td>0.0:0.0:10.0:100.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:35:54</td>
<td>-1.0:0.0:-1.0:10.0:100.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:35:56</td>
<td>-1.0:0.0:-1.0:10.0:98.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:35:58</td>
<td>-1.0:0.0:-1.0:10.0:96.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:00</td>
<td>-1.0:1.0:0.0:0.0:94.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:02</td>
<td>0.0:1.0:0.0:0.0:92.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:04</td>
<td>0.0:1.0:0.0:0.0:90.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:06</td>
<td>0.0:1.0:0.0:0.0:88.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:08</td>
<td>0.0:1.0:0.0:0.0:86.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:10</td>
<td>0.0:1.0:0.0:0.0:84.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:12</td>
<td>0.0:1.0:0.0:0.0:82.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:14</td>
<td>0.0:1.0:0.0:0.0:80.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:16</td>
<td>0.0:1.0:0.0:0.0:78.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:18</td>
<td>-1.0:2.0:0.0:0.0:76.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:20</td>
<td>-1.0:4.0:0.0:0.0:74.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:22</td>
<td>-1.0:6.0:0.0:0.0:72.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:24</td>
<td>-1.0:8.0:0.0:0.0:70.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:26</td>
<td>-1.0:10.0:0.0:0.0:68.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:28</td>
<td>-1.0:12.0:0.0:0.0:66.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:30</td>
<td>-1.0:14.0:0.0:0.0:64.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:32</td>
<td>-1.0:16.0:0.0:0.0:62.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:34</td>
<td>-1.0:18.0:0.0:0.0:60.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:36</td>
<td>-1.0:20.0:0.0:0.0:58.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:38</td>
<td>-1.0:22.0:0.0:0.0:56.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:40</td>
<td>-1.0:24.0:0.0:0.0:54.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:42</td>
<td>-1.0:26.0:0.0:0.0:52.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29.10.2008</td>
<td>22:36:44</td>
<td>-1.0:28.0:0.0:0.0:50.0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Save To File

Saves text to the selected file.
2.10 Common GUI elements

Window menu
Activate Virtual keyboard button

2.10.1 Window menu

Web Client's main window and Web Client's system windows (e.g. Alarm/Event viewers, Trend viewer) contain special combo box so called Window Menu.

Window Menu

Window Menu contains (depending on window type) commands for closing, maximizing and minimizing the window. The commands have the same functionality as commands contained in the title bar (to ensure compatibility with operation systems where title bar is not standard part of the window).

2.10.2 Virtual keyboard button

Some dialog windows (e.g. User Logon and Edit Tag Value) contain the Virtual keyboard button. The button brings up the Virtual keyboard.
2.11 Options

The Options dialog window enables the user to change Web Client settings.

Tools – Options

Alarms/Events

Basic

The Play Sounds parameter enables/disables sounds associated with alarms/events. This parameter is available only in the Current Alarm/Event viewer.

Columns

Defines visibility and position of columns displayed in the Alarm/Event viewers. It is possible to configure columns in the Current Alarm/Event viewer, in the Current Alarm/Event viewer embedded in the Container type component and in the Historical Alarm/Event viewer.
Reports

Defines the format used to view Reports and Custom Reports (HTML or PDF). Report is dynamically generated by the data server in selected format and displayed in the default browse.

Page

Defines the layout of generated HTML page for large reports (multiple pages).

IP Cameras

Defines the image refresh interval of IP cameras. If the Direct Connection parametr is activated then the image will be provided directly by IP camera. In other case the image will be provided trough the data server.

Confirmations

Defines if a confirmation dialog should be displayed and the automatic answer. Another way to define this settings is with the parameter "Don't show this message again" in the confirmation dialog.

Look & Feel

Enables the user to select GUI graphical theme. The list of available themes depends on an OS and on the JRE version. Changes will take effect after restart of Web Client.

Use System Font

Defines if operation system's font should be used for controls.

Log

Enables logging of various information internally generated by Web Client. The logs are stored in the user's profile (Documents and Settings) and can be requested by the software author to help resolving eventual problems.

Miscellaneous

Send Anonymous Usage Statistics

Defines if anonymous information on usage of the Web Client should be send to a GEOVAP, s.r.o. company server. Information is sent always when program starts and it is used only for statistic purposes.
The Web Client's settings are stored in the Operation System user's profile, which means that settings are common to all visualization projects. Also other settings, such as system window position or size and column width in alarm/event viewers, are stored in the same way.
3 Appendix

3.1 Glossary

**JNLP** *(Java Network Launching Protocol)*
Protocol designed to start program written in the Java programming language via Internet (Java Web Start).

**PDF** *(Portable Document Format)*
A file format created by Adobe Systems for document exchange. PDF is used for representing documents in a form independent of software and hardware.

**CSV** *(Comma-separated values)*
A simple text based format designed for exchange of tabular data.

**Data servers**
A common term for the **Reliance Server** and **Reliance Control Server** runtime software.

**HTML** *(Hypertext Markup Language)*
A markup language for creating Web pages.

**Java Web Start**
A framework developed by Sun Microsystems that allows starting and automatically updating programs written in Java directly from Web pages.

**JRE** *(Java Runtime Environment)*
The runtime environment for programs written in Java.

**SOAP** *(Simple Object Access Protocol)*
A protocol for exchanging XML-based messages over the Internet, usually via HTTP.

**TCP port**
A special number used to map data to a particular process running on a computer.

**Thin clients**
A common term for **Reliance Web Client** and **Reliance Smart Client** (designed for use with smartphones and tablets).
**Web server**

A program responsible for processing HTTP requests from clients, usually from Web browsers. Processing a request means, for example, delivering a Web page.

**Web service**

A part of a program that allows data exchange with client applications over the Internet by means of the SOAP protocol. To transfer the data, the Web service uses a Web server.